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Chapter 1.  ImageDealer Overview

ImageDealer provides a quick and convenient way to select a random sampling of images from 
multiple sources. It preserves a natural, random flow of your images—like dealing from a well-
shuffled deck of cards. ImageDealer randomly draws copies of images from your folders or from 
your iPhoto or Aperture Albums and Smart Albums, then deals them into a destination folder 
on your computer or a storage device such as an SD card or an attached media player or other 
device. You can then load the new set of images onto your digital picture frame, TiVo, or other 
display device. 

You tell ImageDealer the source albums or folders, the destination folder, and either the 
maximum number of files to deal or the maximum combined size of the entire dealt image set. 
ImageDealer will shuffle the images into a random order before dealing, or you can choose 
to arrange them alphabetically instead. If you select multiple sources for your images, you can 
control the relative portions from each source.

ImageDealer Uses
Whether you use it for your personal or professional needs, ImageDealer is ideal for creating a 
set of images for display in your digital picture frame or iPod, or on your networked television or 
other display monitor. Now you can put together sets of images without having to manually sort 
through your photos. Using your iPhoto or Aperture Albums or Smart Albums as the source, you 
can easily and quickly deal a set of photos on a specific topic, in a particular color scheme, with a 
specific rating—or even for a particular client. Following are some ways that you can use photo 
sets created with ImageDealer.

Do you keep a digital frame on your desk at work? Set up an ImageDealer project •	
for your frame that will allow you to easily change the photos each week—always 
maintaining the random sampling and never adding duplicates.

Did you get a new digital frame as a gift for a family member? Make the gift extra •	
special. Use ImageDealer to quickly create a sampling of family snapshots, then preload 
them on the frame before giving it away. 
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Having a party at your house? Use ImageDealer to create a photo set that your guests •	
will enjoy, then use your TiVo or other media display device to show them off on your 
television. Wedding shower? Show pictures of the bride and groom. Oscar party? 
Show pictures of your favorite celebrities or pictures from your previous celebrations. 

Are you a professional photographer or artist? Use ImageDealer to create projects •	
based on a specific topic or your target market, then you can easily and quickly set up 
digital portfolios for your client visits or events on the fly.

Do you use a shared folder where you and your friends or colleagues regularly put •	
images? Use ImageDealer with “Manual” Replenish Mode to easily deal sets of only the 
new images for show on your display device.
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Chapter 2. Getting Started

Installation
To install ImageDealer, copy the ImageDealer.app file to your Application folder. You can add 
ImageDealer to your Dock by dragging the program from your Application folder to the Dock. 

To uninstall ImageDealer, delete it from your Application folder and from your Dock. Be sure to 
write down your License number first in case you want to reinstall the program later.

Licensing
ImageDealer is available as a fully-functional trial version that allows you to use it for up to 14 days 
before buying it. After the trial period, the program will no longer run unless you license it. To 
license the program, choose “License…” from the ImageDealer menu. You can then either click 
the “Buy...” button to purchase the program, or if you have already purchased it click “License...” to 
enter your name and license key.

Updates
You can check for updates any time by choosing “Check for updates...” from the ImageDealer 
menu. This will go to the Raging Fjord website and check to see if an updated version of the 
software is available. If an update is available, you will be asked if you would like to install it. 

You can also set your ImageDealer preferences to automatically check for updates each time it is 
started up. See “Preferences” in Chapter 3 for more information.

Getting Help
Use the Help menu to get help at any time. It allows you to search for specific terms, access the 
main ImageDealer Help book, or go to the Raging Fjord website. We have created a support 
portal on our website at www.ragingfjord.com/support that includes this user guide, answers 
to every question we’ve received, and thorough explanations of how to do everything you want 
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to do with your software. If the answers you need aren’t there, we invite you to send us your 
question and an actual human will respond to your email.

Preferences
Choose  “Preferences...” from the ImageDealer menu, or press ⌘ (Command-comma), on your 
keyboard to access the Preferences dialog (Figure 1). Here you can specify whether you would 
like to see the Results window after each deal, whether ImageDealer should check for updates at 
startup, and what you want ImageDealer to do if it encounters files in your destination folder. 

About Raging Fjord
Raging Fjord Software is a group of engineering and marketing professionals dedicated to making 
quality software for Macintosh users. Visit our website at www.ragingfjord.com for information 
about this and other software that is available.  
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Chapter 3.  Using ImageDealer

Quick Start
This manual gives you lots of details and describes all the options, but we don’t want you to think 
that using ImageDealer is complicated! Want to quickly get going without having to read the 
whole manual? Here is the process in four easy steps:

Create a new project1.	  
Click the  button on the Projects Window. (Details start on page 11.)
Set a few project details2.	  
Specify the destination and optional limits. (Details start on page 11.)
Add one or more sources3.	  
Tell ImageDealer where to copy images from. (Details start on page 14.) 
Deal4.	  
Click the Deal button and you’re done! (Details start on page 9.) 

Projects
Your Projects are accessed on the Projects window (Figure 2). 
Figure 2. The Projects Window
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Your choices of which sources to draw images from, how many images to take from each source, 
where to deal the chosen images to, how to arrange them, and other settings are stored in 
individual Projects. Below each project name is the last date that it was dealt. Click on the column 
head to alphabeticaly sort your list of projects. There is no limit to the number of Projects that 
you can have.  

Note: Well, to be honest, there is a limit to the number of Projects you can have:  you are 
limited by the amount of memory in your computer. This means that once you have about fifteen 
thousand Projects, ImageDealer might start to perform slowly or unpredictably. It’s easier to just 
say that there is no limit.

Selecting and Dealing a Project
Select a project then click the “Deal” button to have ImageDealer deal images—or copy a 
randomized selection—to your destination. If the destination device or folder is not empty, 
ImageDealer will tell you this and ask you how to proceed by showing you the Image Deletion 
dialog (Figure 3). 

This dialog lists any files found in your destination that were not dealt by this particular project 
and let’s you choose how to proceed. As you select different options, the box on the right side 
lists the files which will be affected.
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Figure 3. The Files Found Dialog

Select the desired action, then click OK to continue.

Delete only the images we dealt. •	 Deletes only the images placed in the destination 
by ImageDealer (by this project).
Don’t delete any images. •	 Select this option to add the images of this deal to the 
images that are already in the destination folder.
Delete ALL images.•	  Select this option to delete all the images before dealing your 
new images into the destination folder.
Stop the deal. •	 Select this option to stop the deal without deleting or copying images.

Depending on your Preference settings, a dialog showing the results of the deal will be shown 
when the deal is completed (Figure 4). See Chapter 4 for details on exactly how ImageDealer 
deals your image set.
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Figure 4. The Results Window

Note: If you would rather not see the Results window after each Deal, you can disable it by 
unchecking the checkbox in the Preferences, accessed from the File menu.

Edit Or Create a New Project
To edit a project, double-click on its name in the Projects window, or click to select it then click 
the “Edit” button.  

To create a new project, click on the  button on the Projects window, or choose “New Project” 
from the File menu or press  ⌘ n (Command-n), on your keyboard. This will open the Project 
Details window (Figure 5). The Project Details window is where you tell ImageDealer which 
folders or albums to include in the project and in what proportions, how to arrange the selected 
images, and how big the dealt image set should be. 

The Project Details window has three views: Settings, Sources, and Last Deal. Use the Settings 
view to enter basic settings for your overall project. Use the Sources view to select the folders 
and albums to include in your project. Use the Last Deal view to see details about the last time 
your project was dealt. Following are details on how to complete the Project Details window to 
create a project.

Project Details: Settings View
Project Name. Enter a name for your project in the Project Name field. Choose a name that 
gives you an idea of what kind of project it is. For example, you might have a project called “My 
office frame” for refreshing the photos on the frame you keep at work, and another called “My 
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Portfolio” for the professional photography collection that you put on your digital portfolio. 
Giving your project a descriptive name now will help you find it later. 
Figure 5. The Project Details Window: Settings View

Destination Folder. Click on the Destination Folder selector to select the location to which you 
would like ImageDealer to deal your new image sets. Some people deal their projects directly 
onto their SD cards or external devices, and other people deal their projects to a folder on their 
hard disk which they can then copy to some place else. 

Count and Size Limits. Tell ImageDealer how large the set of dealt images should be for this 
project by telling it the maximum storage space it can use in the Size Limit field, or the maximum 
number of images in the Count Limit field. Set one or both parameters then click the checkboxes 
to tell ImageDealer which limit to use. If you select both, then ImageDealer will base the deal on 
whichever limit it encounters first. 
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The limits you set depend on what you plan to do with the images. For example, if you plan to 
load the images on a digital picture frame, enter the limits that are given in the user manual that 
came with the frame or use a limit based on the total capacity of your SD card.

Count Limit: •	 Enter the number of images that you would like to have in the final set. 
ImageDealer will not treat this as a target quantity, but rather as a maximum limit. Depending 
on the Portion and Replenish Mode specified for the source, the final image count may be 
less than the specified Count Limit. 

Size Limit: •	 Enter a number in the Size Limit field and also select Megabytes (MB), Gigabytes 
(GB), or Kilobytes (KB). ImageDealer does not choose images based on size to allow filling 
every last byte - it just stops when the next image it would draw is too large to fit in the 
remaining space.

Note: ImageDealer will deal the Project up to the first limit it reaches. For example, consider a 
Project where the Size Limit is 10MB and the Count Limit is 100. As ImageDealer is dealing the 
Project, there are a few very large images in the source folders, so that it reaches the 10MB limit 
after it deals the 85th image., so the final Project set will have just 85 images. 

If no limits (size or count) are set, ImageDealer will estimate how many images can fit in the 
entire space available on the destination media (SD card, hard disk, etc.) and attempt to fill the 
destination device with as many images as possible. If no limits are set and your destination is a 
non-removable drive (such as the hard disk inside your Mac), then you will be warned when you 
begin a deal, since filling an internal hard disk with photos is probably not something you want to 
do!

Note: MSDOS formatted destinations (like most USB flash drives and SD cards) are a special case.  
The MSDOS FAT16 and FAT32 file systems have a limit on how many files can be placed into the 
root of the drive. This limit varies, so in almost all cases you should create a folder (sub-directory) 
on the device and deal your images into that folder. If you select the root of an MSDOS volume 
as your destination, a warning alert will be shown.
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Arrange Dealt Images. ImageDealer draws images from your sources randomly (unless you use 
the “Make Sequences” setting described later). Arrange Dealt Images tells ImageDealer how to 
sort the images before it deals them into the destination and it applies to all the images in the 
project. 

Random:•	  Select the default “Random” arrangement method to tell ImageDealer to randomly 
shuffle  the images, resulting in “patternless” presentations that flow evenly. 

•	 Keep Portion Pattern: Preserves the pattern established by the Portion setting. For example, 
If you have three sources, and each has the Portion set to 5,  the Keep Portion Pattern 
arrangement setting will ensure that your images appear in the exact order in which they 
were selected—with each randomly-selected Portion of five images grouped together. 
In short--this arrangement will display your images in the same order in whicxh they were 
drawn from their sources.

Alphabetic: •	 Select this arrangement to arrange your images in alphabetic order by file 
name. If you would like to present your images in a particular order, you must name the 
source files BEFORE you deal them so that they will go in the correct order alphabetically, 
then select “Alphabetic” as the arrangement method. 

Note: The method you choose to arrange dealt images applies to the entire project. For 
example “Alphabetic” can be used to preserve a sequential order for all the images from all the 
sources in the deal. If you want to preserve the sequence of only a few specific images, select the 
“Keep Portion Pattern” arrangement mode, then use the Make Sequences feature described later 
in this chapter.

Aperture Export Setting. If any of your sources will be from Aperture Albums, then you must 
specify your Aperture Export setting.  The choices in this drop-down list will correspond to your 
export settings in Aperture, such as “JPEG - Original Size,” and “PNG - Fit within 1024 x 1024.” 

Project Details: Sources View
For each project you will select one or more sources from which ImageDealer will copy images. 
These sources can be folders on your computer or Albums or Smart Albums in iPhoto or 
Aperture. Click on the “Sources” button to open the Sources view on the Project Details window 
(Figure 6). 
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Figure 6. The Project Details Window: Sources View

Note: An ideal use of ImageDealer is to draw images from one or more Smart Albums in iPhoto 
or Aperture. Using Smart Albums will allow you to limit the pool of source images to only your 
favorites, or only those with specific keywords. 

The sources are shown in the list on the left side of the window. The icon will tell you whether the 
source is a folder, iPhoto, or Aperture. The numbers beneath the source name tell you how many 
images are in the source and how many are available. Only images that have not yet been dealt 
are available. See “Replenish Mode” for more information. To make changes to a source, click on it 
to select it, then change the options on the right side of the window. 

Note: Rearrange the order of the sources by dragging and dropping the rows in the list.

To add a new source to your project, click on the  button beneath the list on the left side of the 
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window., then modify the source details as described below.

Get images from. Use this field to tell ImageDealer what type of source this is. What you select 
in the “Get images from” selector field will control the name and action of the next field. 

Folder:•	  This will make the next field say “Folder”, and clicking on the icon will let you select a 
folder on your computer.
iPhoto or Aperture:•	  This will make the next field say “Album”, and clicking on the iPhoto or 
Aperture icon will let you select an Album or Smart Album.

Portion. Portion tells ImageDealer two things: what portion of the total images to take from 
each of your sources, and what pattern to use in the arrangement of images (if you select Keep 
Portion Pattern when you choose the arrangement). Use the slider or the Portion text field to 
specify a portion from 1 to 50. If you select only one source in the project, then the Portion will 
be ignored.  

Make Sequences. Check the Make Sequences checkbox to tell ImageDealer that if it encounters 
filenames that are identical except that they end with sequential numbers, then they should be 
drawn in that sequence (as opposed to the random drawing order that ImageDealer normally 
uses.) For example, file names that would be affected by Make Sequences are MyPic_002, 
MyPic_003, MyPic_004. This allows you to include all the images from a sequence in the deal, up 
to the limits set for your project.

Note: Many digital cameras use a sequential naming method for naming the files as you take 
pictures. For example,  DSC_1350.jpg, DSC_1351.jpg, etc.  Use the “Keep Portion Pattern” 
arrangement mode in conjunction with the Make Sequence feature to create a dealt set that 
displays your images in the same order in which they were photographed.

Replenish Mode. As ImageDealer copies images from your sources, it keeps track of which 
images it has used so that it will not include duplicate photos in your dealt image sets. The 
Replenish Mode tells ImageDealer what to do when it has run out of original, “undealt”  images in 
the source—or how to replenish the source.
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Note: ImageDealer keeps track of which images have already been dealt—not just during a 
single deal, but in subsequent deals as well. This means that if you have a folder with 1,000 
images and you use a Count Limit of 100, you can count on about 10 deals before you see a 
duplicate image (unless you replenish the source manually).

Manual: •	 Select Manual to tell ImageDealer that when it runs out of undealt images it should 
skip that source until the it has been manually replenished (or until new images are added to 
that source). For any source with a Replenish Mode set to Manual, you click the “Replenish” 
button to reset all the images in the source. ImageDealer would then consider all the images 
undealt and again include the source in deals for that Project.

Automatic: •	 Select Automatic to tell ImageDealer that when it runs out of undealt images in 
the source, that it can just start from the beginning again, considering all the images in the 
source undealt. 

Replenish Button. When you click the “Replenish” button you will be asked to confirm that you 
want to go through with the Replenish process because it cannot be undone (Figure 7). Click the 
“Yes” button to proceed, and all the images in the source will be considered undealt and available 
for future deals.

Figure 7. The Replenish Source Confirmation Dialog 

Note: You can replenish specific sources rather than the all the sources in the entire project by 
selecting the source then clicking the “Replenish” button for that source.
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Project Details: Last Deal View
Click on the “Last Deal” button to open the Last Deal view on the Project Details window (Figure 
8). This view shows you the results of the last deal, including the file names of all the images 
included in the deal.
Figure 8. The Project Details Window: Last Deal View
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Chapter 4.  Portion and Replenish Mode

The Portion and Replenish Mode settings interact to control which images are selected as 
ImageDealer deals your images.

ImageDealer goes through each source in your project, reads the Portion number, then copies 
undealt images to your destination. After copying undealt images from each source, it checks 
the Size Limit and Count Limit for the project. If it has not reached one of those limits, then it 
proceeds to the next source. 

If ImageDealer still has not reached a Count Limit or Size Limit when it has gone through all of the 
sources, it will go back to the beginning and go through the sources again. It will continue in this 
fashion until it reaches one of the limits set for the project.

When ImageDealer runs out of undealt images and if the Replenish Mode is Automatic, then it 
will reset all the images for the source, basically setting the entire source as undealt. If it runs out 
of undealt images and the Replenish Mode is Manual, then it will move on to the next source. It 
will continue to check the source in case new images have been added, as any new image would 
be considered undealt and could be included in a new deal. But no images will be copied from 
this source until new images are added to it or it is replenished.

ImageDealer Scenario: A Normal Deal 
Following is a step-by-step description of how ImageDealer selects your images and deals them 
to the destination.

1. ImageDealer accesses the source and checks to see if it 
has any undealt images, which are images that have not 
yet been copied into the destination.
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2. If there are undealt images in the source, ImageDealer 
takes copies of the number of images that was set as the 
Portion for the source. If the source runs out of undealt 
images, then ImageDealer will follow the steps shown in 
the “Dealt Sources” scenario.

3. ImageDealer deals the copied images to the Destination, 
then it checks to see if either of the limits have been 
reached.

4. If a limit has not been reached, then ImageDealer will go 
to the next source in the list and start the process over 
again, continuing until a limit is reached.

ImageDealer Scenario: Dealt Sources 
Following is a step-by-step description of what ImageDealer does when a source runs out of 
undealt images.

1. ImageDealer finds that there are not enough 
undealt images to make up the Portion that is 
specified for the source. It copies all the remaining 
undealt images, then it checks to see what 
Replenish Mode is set for this source.

2. If the Replenish Mode is Automatic then the 
source is replenished, making all the images 
undealt (except for the images that were copied 
in Step 1 above). ImageDealer copies images to 
add to those copied in Step 1 to reach the Portion 
number.

3. If the Replenish Mode is Manual then ImageDealer 
will stop drawing copies from this source until it is 
replenished, or until new photos are added to it.
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